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1. INTRODUCTION 
1.1. SCOPE 
 
This document describes the operation and maintenance of the 6640T Series of Automatic DCC 
Resistance Bridges. 
 
1.2. GENERAL DESCRIPTION 
 
The 6640T series bridges can be controlled from the front panel or by a computer system through 
software.  The BridgeWorks Software User’s Manual describes the operation of the 6640T with 
the software. Once the computer system is installed and connected to the IEEE-488 Interface of the 
6640T Resistance Bridge, full software control of the bridge is possible.  The following models are 
described in this manual. 
6640T-B (Base model with measurement up to 100 kΩ) 
6640T-XP (eXtended Precision model with measurement up to 100 kΩ, and lower uncertainies) 
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1.3. OVERVIEW 
 
The 6640T is a microprocessor-based, direct-current-comparator bridge designed for the automatic 
measurement and display of the ratio of two resistances to accuracies better than 0.1 µΩ/Ω.  The 
ratio of the two resistances is determined from a direct measurement of the voltage of the bridge 
imbalance while an ampere-turn balance is maintained.  A microprocessor is used to control the 
direct-current-comparator, set the bridge measurement currents and measurement configuration, 
initiate the voltage measurement cycle and maintain the ampere-turn balance.  This fully automated 
measurement process achieves optimum resistance ratio resolution and accuracy at the sub-ppm 
level. 
 
The bridge is designed for flexibility and ease of use and is based on the direct-current-comparator 
bridge (DCC) originally developed by the National Research Council of Canada.  Guildline first 
commercialized DCC Temperature Bridges (i.e. model 9975), and subsequently made major 
enhancements with the Guildline 6675(A) and 6622T automated temperature bridges.1.  The 6640T 
contains additional improvements, which are protected by two patents, and provides the best 
commercially available temperature bridge.  Remote access to the embedded microprocessor-
controller, through a simple control language command set and GPIB communication interface 
allows the 6640T to fully exploit the capabilities of the direct-current-comparator to suit each user 
requirement while still maintaining optimum resistance ratio measurement accuracy at the sub-ppm 
level. 
 
The design approach taken for the 6640T results in an effective bridge measurement accuracy of 27 
bits (to a maximum of 32 bits depending on configuration), allowing the resistance ratio of 
resistances in the range 0.001 Ω to 100 kΩ to be automatically measured.  Options are available to 
extend the measurement range to 1 GΩ. 
 
The balance of the zero ampere-turn flux condition is maintained automatically using an electronic 
closed loop feedback network operating on the flux detector output to drive a slave power supply 
for the standard resistor current.  The bridge balance (null voltage condition) is maintained 
automatically by adjusting the number of turns in series with the unknown resistor. 

 
    1 MacMartin, M.P. and Kusters, N.L., "A direct -current-comparator for four terminal 

resistance measurements", IEEE Trans. Instrumentation and Measurement, vol IM-15, 
pp.212-220, December 1966. 
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1.4. PRINCIPLE OF OPERATION 
 

A simplified diagram of the automatic direct-current-comparator is shown in Figure 1-1.  
Two sets of four terminal connections hardware are provided, one set for the standard 
resistor and one set for the unknown resistance.  A current (Ix), set under control of the 
microprocessor, is passed through the variable turns of winding (Nx) of the comparator and 
through the unknown resistance (Rx).  The isolated slave current (Is) is generated under 
microprocessor control, as a linear function of the number of turns (Nx) and is forced 
through the fixed slave windings (Ns) and the reference resistor (Rs).  The currents (Is) and 
(Ix) flowing in the windings (Ns) and (Nx) respectively generate a net magnetic flux 
imbalance in the flux detector windings (Nd).  This flux imbalance is proportional to the net 
ampere-turn error between the two windings [(Is) x (Ns)] and [(Ix) x (Nx)].  By sensing this 
imbalance with the sensitive flux detector winding and an electronic peak detector, a voltage 
signal is generated proportional to the sign and magnitude of the ampere-turn error.  This 
voltage is used in a simple closed loop control configuration to adjust the slave current (Is) 
to bring the (ampere-turn) error signal to zero.  At balance, the ratio of the two currents (Ix 
and Is) flowing in the two windings is the same as the ratio of the turns set for each winding 
(Nx and Ns). 

 
Complete electrical isolation between circuit currents is maintained throughout the 6640T 
by making full use of fiber optic technology.  A fiber optic serial data communication link is 
used to transfer data between each functional component and the embedded microcontroller. 

 
A link joining the two potential leads of the unknown resistance (Rx) and the reference 
resistance (Rs) and the nanovoltmeter detector provides the only connection between the 
two halves of the bridge.  Power supply isolation techniques as recommended by Kibble2  
are used throughout to further isolate the bridge halves.  The nanovolt detector is a high 
input impedance (>1 GΩ) amplifier arrangement capable of resolving voltages at the 
nanovolt level with a typical linearity accuracy of 14 bits (to a maximum of 22 bits).  In the 
automatic direct-current-comparator bridge arrangement this amplifier is used to measure 
the potential across the reference and unknown resistances. 

 
Knowledge of the reference resistance value (Rs), the effective resistance potential 
imbalance and confirmation that ampere-turn balance is maintained, with the turns (Nx, Ns) 
and current (Ix, Is) settings, allows the unknown resistance value (Rx) to be calculated. 

 
    2 Kibble, B.P. and Robinson, I.A., "An Isolated Mains Driven Power Supply", NPL 

Memorandum DES 54, September 1985. 
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Figure 1-1 : Model 6640T Block Diagram 
 

1.4.1.1. Normal Ohm Measurement Mode 
This mode allows a 4-terminal resistance measurement to be made from 1 mΩ ≤Rx≤ 
100 kΩ.  No external devices (except the two resistors) are required with the 6640T 
to make this measurement. 
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2. PERFORMANCE SPECIFICATIONS 
 
2.1. 6640T SERIES TEMPERATURE MEASUREMENT SPECIFICATION 
 

Base Range: 
maximum 100 kΩ 6640T-BASE 

INTERCHANGE 

1 
SPECIFICATION 

RESISTANCE  
STANDARD 3  Y E A R  R A T I O  S P E C I F I C A T I O N S 2  

0.8 > Rx < 4.3 ◄ ACTUAL RATIO ► 0.08 > Rx < 0.5 0.5 > Rx < 4.3 4.3 > Rx < 13.4 13.4 > Rx < 107.5 

1 : 1 ◄ NOMINAL RATIO ► 0.1 : 1 1 : 1 10 : 1 100 : 1 

± 0. 0 3 µΩ/Ω ◄ 1  Ω  ► ±  0 . 2  µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 1  µΩ/Ω 

± 0. 0 3 µΩ/Ω ◄ 1 0  Ω  ► ±  0 . 2  µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 1  µΩ/Ω 

± 0. 0 3 µΩ/Ω ◄ 1 0 0  Ω  ► ±  0 . 2  µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 3  µΩ/Ω 

± 0. 0 3 µΩ/Ω ◄ 1  k Ω  ► ±  0 . 2  µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 1  µΩ/Ω ±  0 . 8  µΩ/Ω 

± 0. 0 5 µΩ/Ω ◄ 1 0  k Ω  ► ±  0 . 2  µΩ/Ω ±  0 . 1  µΩ/Ω ±  0 . 2  µΩ/Ω RESISTANCE OPTION 

 
 

XP Range:   
maximum 100 kΩ 6640T-XP 

INTERCHANGE 

1 
SPECIFICATION 

RESISTANCE  
STANDARD 3  Y E A R  R A T I O  S P E C I F I C A T I O N S 2  

0.8 > Rx < 4.3 ◄ ACTUAL RATIO ► 0.08 > Rx < 0.5 0.5 > Rx < 4.3 4.3 > Rx < 13.4 13.4 > Rx < 107.5 

1 : 1 ◄ NOMINAL RATIO ► 0.1 : 1 1 : 1 10 : 1 100 : 1 

± 0. 0 2 µΩ/Ω ◄ 1  Ω  ► ±  0 . 1  µΩ/Ω ±  0 . 0 2 µΩ/Ω ±  0 . 0 2 µΩ/Ω ±  0 . 1  µΩ/Ω 

± 0. 0 2 µΩ/Ω ◄ 1 0  Ω  ► ±  0 . 1  µΩ/Ω ±  0 . 0 2 µΩ/Ω ±  0 . 0 2 µΩ/Ω ±  0 . 1  µΩ/Ω 

± 0. 0 2 µΩ/Ω ◄ 1 0 0  Ω  ► ±  0 . 1  µΩ/Ω ±  0 . 0 2 µΩ/Ω ±  0 . 0 2 µΩ/Ω ±  0 . 3  µΩ/Ω 

± 0. 0 2 µΩ/Ω ◄ 1  k Ω  ► ±  0 . 1  µΩ/Ω ±  0 . 0 2 µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 8  µΩ/Ω 

± 0. 0 3 µΩ/Ω ◄ 1 0  k Ω  ► ±  0 . 1  µΩ/Ω ±  0 . 0 5 µΩ/Ω ±  0 . 1  µΩ/Ω RESISTANCE OPTION  
 

1 - Interchange specification (i.e. sometimes referred to as a self-calibration) with minimal filtering. 
2 - 3 Year Calibration interval with annual performance verification (automated). 
3 - Specifications are based on 1 mW of power and temperature of 23 °C ± 2 °C.  
4 - Ranges below 1 Ohm are only available for a Rs of 1 Ω. 
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6640T Series General Specifications 

Linearity < ± 0.005 µΩ/Ω (1:1 to 13.4:1) 

Display Resolution (µΩ/Ω) Selectable from 0.0001 (µΩ/Ω) to 10 (µΩ/Ω) 

Temperature Coefficient  0.01 µΩ/Ω /ºC of reading (Outside 23 ˚C ± 3 ˚C) 

Automatic Current Reversal Rate (in seconds)  4 to 1637 programmable, increment of 1 second 

Fastest Measurement Sample Rate 2 seconds 

Communication  
USB, Network, IEEE 488.2 (Optional), SCPI Based 
Instructions 

Test current (for 
measurements to 
100 kΩ) 

Usable range (± 30 V 
compliance) (A) 

10 µA ~ 150 mA (extension to 10,000 A available for 
resistance measurements) 

Resolution (µA) 1 µA 

Accuracy [error(µA/A) + 
offset(A)] ± 100 µA/A ± 10 µA 

Bridge Operating Temperature to Full Specifications 23 °C ± 2 °C 73 °F ± 5 °F 

Bridge Maximum Operating Range (<50 % RH) +18 °C to + 28 °C +65 °F to +82 °F 

Bridge Temperature Storage Range -20 °C to + 60 °C -4 °F to +140 °F 

Power Requirements VAC: 100 V, 120 V, 220 V and 240 V ± 10 % / 50 or 60 Hz ± 5 %, 200 VA 

Fuse Requirements 
(Time Delay Type) 

100 V – 120 V 
2.5 A (T) Guildline # 099-22501 

220 V – 240 V 
1.5 A (T) Guildline # 099-21501 

Dimensions (Width x Height x Depth) Weight 

440 mm x 200 mm x 465 mm 17.3” x 7.8” x 18.3” 27 kg 59.5 lbs 

 
Note:  The 6640T-Base and 6640T-XP Models are limited to a maximum of 100 kΩ with a maximum Rs (Resistance 
Standard) of 10 kΩ.  Because of the unique variable ratios available on all models, it is possible to measure UUT’s 
with a variety of Rs Standards.  For example, a 10 kΩ UUT could be measured with a 100 Ω, 1 kΩ and 10 kΩ 
Resistance Standard (Rs).  To determine the measurement uncertainty due to the bridge, simply look at the Rs you 
are using, and then go to the appropriate UUT Sub range.   
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3. OPERATING INSTRUCTIONS 
3.1. FRONT PANEL OPERATING PROCEDURE 
 
The 6640 Graphical User Interface (or GUI) is provided on a Windows 10 embedded PC which 
is connected to the bridge hardware.  The interface utilizes the touchscreen interface with on 
screen keyboard for user control and entry.  The GUI user interface software utilizes the full 
screen as a “Metro” style application common to Windows 8 and newer.  Note that this interface 
runs on Professional (x86 and x64) versions of windows and is not supported in RT versions.  
The 6640 GUI replaces the traditional front panel interface with an intuitive and powerful 
Graphical User Interface optimized for the large embedded touch screen.  This interface provides 
manual control for individual tests. 
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The GUI consists of the main screen and various set up and configuration screens for controlling 
the bridge and displaying measurement results.  In the diagram below is a high-level 
navigation/hierarchy map of the GUI screens. 
 
 
 
 

 
 
 
 

 
 

Figure 3-1 : User Interface Navigation Diagram 
 
As shown in the diagram above all screens can be easily accessed starting from the main screen of 
the 6640 GUI. 
 
Also note that this interface can be installed and run on any computer running Windows 7 or newer 
and can run as a standard desktop app “Windowed”, rather than full screen “Metro” mode by 
changing the “TabletPC” from true to false in the “Bridge6640.ini” file. 
 
Note that to edit the ‘ini’ file you will need administrative privileges in Windows. 

Main 

Test Options Ratio 

File Configuration View Test Setup Scanner 
Setup 

Maintenance 
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3.2. MAIN SCREEN 
 
The main screen of the user interface is where you have access to all user features of the 6640T 
Temperature Bridge.  The screen has operator functions available mainly to the right hand side of 
the screen with statistics at the top of the screen and graph to the left.  The graph will 
automatically adjust the scale such that all data will be visible up to a maximum length of hours 
as defined in the Setup GUI screen.  If data is being logged all data is still available in the stored 
file. 
 

 
 
The data on the graph can be cleared by changing the ‘Recent Samples’ count to 0, then setting it 
back to 35 or desired number.  Note that the statistics will be cleared as well.  These statistics 
reflect all the present data in the graph. 
 

3.2.1. Stop 
The “Stop” button stops the measurement.  To exit the 6640 Graphical User Interface, 
Select “Quit” in the “Options” menu under the “File” drop down menu. The 6640T will 
retain all data if the data logging feature is turned on. 
 
To START a measurement select ‘Test’, then fill in the information in ‘Test Setup’ and 
hit ‘Start’. 
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3.2.2. Options 
The “Options” button goes to the following screen with the following options: ‘File’, 
‘Configuration’, ‘View’, and ‘Maintenance’. 
The “Info” selection displays Guildline contact information, and the version number of the 
firmware installed on the 6640T. 
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Test 
The “Test” option goes to the following screen.  The ‘Scanner Setup’ portion can be 
ignored if a direct measurement is being made with the 6640T (i.e. no scanner is being 
used).  
To make a FRONT PANEL MEASUREMENT select ‘Insert’, leave the ‘Rx Ch’, Rs 
Ch’ ‘mA in Normal’ and ‘Rs’ defaults as is.  Select the ‘Reversal Rate’ and enter desired 
value.  For use with a 25 Ohm SPRT it is recommended that a reversal rate of 20 seconds 
be used.  If a power level less than 1 mW is being specified a longer reversal rate needs to 
used, such as 60 seconds or even 120 seconds.  Note that two measurements are made 
during one polarity reversal (i.e. one measurement at each polarity) so the measurement 
rate is ½ the reversal rate.  With a reversal rate of 20 seconds a measurement will be made 
every 10 seconds. 
To save the test parameters select ‘Save’ and a window will appear allowing you to 
specify the file name and directory. 
To use saved test parameters select ‘Open’ and a window will appear allowing you to 
specify the file name and directory to use. 
The ‘Environment’ selection allows you to enter a Test Name, Location, laboratory 
Temperature, laboratory Humidity, and laboratory Pressure; all of which will appear on 
the Test Report. 
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For temperature measurements the ‘Ratio’ selection is not used. 
To START the measurement select ‘Start’.  The default is that the measurement will start 
in 1 second but this can be changed in the ‘Start Process’ selection. 
The test will consist of the number of measurements shown in the ‘Sample Limit’, with 
the statistics displayed in the MAIN screen based on the last number of measurements as 
indicated in the ‘sample Window’.  The displayed statistics will be updated after each 
measurement.  Note that the test will automatically stop once the ‘Sample Limit’ is 
reached. 
To return to the MAIN screen select ‘Cancel’ 
 

 
 
To make a MEASUREMENT using a scanner such as a Guildline 3210 or 6664C enter 
channel numbers for ‘Rx Ch’ and ‘Rs Ch’. 
If a Scanner Channel setup has been previously saved it can be accessed via ‘Scanner 
Setup’ and selecting ‘Load’.  A window will appear allowing you to specify the file name 
and directory. 
 
Selecting ‘Edit’ will allow you to enter a profile for the Rs or Rx resistor as per the 
following screen.  Typically reference resistors used for temperature measurements are 
used with current, not voltage. 
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To save the resistor profile select ‘Save’ and a window will appear allowing you to specify 
the file name and directory. 
To select a saved resistor profile select ‘Open’ and a window will appear allowing you to 
specify the file name and directory. 
To return to the Test Setup screen select ‘Close’ 

 
3.2.3. Ratio 
On the “Main” screen under ‘Test’ the option shows what is displayed on the graph and in 
the statistics (i.e. current value, current mean and standard deviation).  The display options 
are:  Ratio, Ohms, Delta PPM, Kelvin, Celsius, or Fahrenheit. 
 

 
3.2.4. Power x1 
The “Power x1” option on the main screen toggles between specified power level for Rx 
and the √2 x specified power level. 
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3.3. OPTIONS FILE SCREENS 
 
The following options are available under the “File” selection. 
 

 
 
The ‘Rescan’ option uses the internal 6640T GPIB to connect the internal 6640T Windows 
computer running the GUI to the internal 6640T real-time computer which actually runs the 
bridge measurements. 
 
Select the ‘Save Data' option and a window will appear allowing you to specify the file name and 
directory where the measurement data is to be saved. 
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Select the ‘Admin’ option and the following screen appears.  Making administrative changes 
requires a password.  The default password is 111.  Once the password is entered press OK. 
 

 
 
When the correct password is entered the following ‘Administration Options’ screen appears.  
Note that the following ‘Administration Options’ screen is used to change the password.  

 

 
The ‘Default Units’ option specifies what is displayed on the MAIN screen graph and on the 
MAIN screen statistics.  The choices are Ratio, Ohms, Delta PPM, Kelvin, Celsius, or 
Fahrenheit. Note that the ‘Units’ can also be changed on the MAIN screen. 
 
The ‘Default Crop’ specifies the last number of measurements to be used for the statistics that 
are displayed on the MAIN screen.  If the ‘Number of Measurements’ is larger than the ‘Default 
Crop’ only the last ‘Default Crop’ measurements will be used for the statistics.  Note that the 
number of measurements to be cropped can also be changed on the MAIN screen using ‘Recent 
Samples’. 
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The ’Filter’ selection enables a digital filter based on the last number of measurements.  A 
simple average of the last number of measurements is reported instead of each individual 
measurement. 
 
The ‘Default Data’, ‘Default Profiles’, ‘Default Sequence’ and ‘Excel Path’ are used to set the 
directory which will be used to store the respective information. 
 
The ‘Set New Password’ option allows you to reset the Administration Password. 
 
The ‘Uncertainty’ selection allows you to choose how uncertainties are combined by selecting:  
‘(direct addition)’ or  ‘(sum of squares)’.  The selection button highlighted in green shows the 
current setting. 
 
The ‘OK’ selection button implements all changes and returns to the ‘Options’ screen.  The 
‘Cancel’ selection button does not make any changes and returns to the ‘Options’ screen. 
 
The “Print” option prints the current data file for the last measurements. 
 
The “Quit” command exits the 6640T Main Menu and returns to Windows. 
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3.4. OPTIONS CONFIGURATION SCREENS 
 
The following options are available under the “Configuration” selection. 
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The ‘Resistor’ selection provides access to the following Resistor Profile sceen.  This screen 
allows a resistor profile to be saved and subsequently used.  Note that resistance standards used for 
temperature measurements typically are used with current and not voltage. 
 
The ‘New’ option allows a new resistor profile to be entered.  The ‘Open’ option allows allows a 
previously stored profile to be loaded while the ‘Save’ option saves the existing resistor profile.   
 
For both the ‘Open’ and ‘Save’ options a window will appear allowing you to specify the file 
name and directory where the reference resistor data is to be respectively loaded from or saved. 
 
The ‘Close’ option returns to the “Configuration” selections. 
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The ‘Probe’ selection provides access to the following Probe Configuration Screen. This screen 
allows a temperature probe profile, and associated ITS-90/PTS-68 coefficients, to be saved and 
subsequently used. 
 
The ‘New’ option allows a new temperature probe profile to be entered.  The ‘Open’ option 
allows allows a previously stored profile to be loaded while the ‘Save’ option saves the existing 
probe profile.   
 
For both the ‘Open’ and ‘Save’ options a window will appear allowing you to specify the file 
name and directory where the probe data is to be respectively loaded from or saved. 
 
The ‘Close’ option returns to the “Configuration” selections. 
 
 
 

 
 
 



 

 
 

Section 3 
 

OM6640T-10-00 
08 March 2024   

3-14 

The ‘Test’ selection provides access to the following Test Configuration Screen. 
 
A description of how this screen works is provided in Section 3.2.2, “Options”, ‘Test’. 
 

 
 
 
The ‘Environment’ selection provides access to the following Test Environment Screen.  
 
The ‘Environment’ selection allows you to enter a Test Name, Location, laboratory Temperature, 
laboratory Humidity, and laboratory Pressure; all of which will appear on the Test Report. 
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The ‘Test’ selection provides access to the following ITS-90 Calibration Utility Screen. 
Enter the range of temperature that a probe will be used for and the appropriate fixed points will be 
identified by the yellow ‘Load’.  Enter the measured resistance for the probe at each respective 
fixed point, select ‘Generate’, and the ITS-90 coefficients will be calculated and displayed. 
 
The ‘New’ option allows a new set of ITS-90 coefficients to be calculated. 
 
The ‘Open’ option allows allows a previously stored set of ITS-90 coefficients to be loaded 
while the ‘Save’ option saves the existing set of ITS-90 coefficients.   
 
For both the ‘Open’ and ‘Save’ options a window will appear allowing you to specify the file 
name and directory where the probe data is to be respectively loaded from or saved. 
 
The ‘Close’ option returns to the “Configuration” selections. 
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The ‘Report’ option displays the following screen. 
 
 

 
 
Selecting ‘Current’ displays the following report. 
 
 

 
 
 
Selecting the ‘File’ (i.e. use Probe profile) option and a window will appear allowing you to 
specify the file name and directory where the probe data is to be loaded from to be used to create a 
ITS-90 Coefficients Report. 
 
Hit the ‘Close’ button on the ITS-90 Coefficients Report to return to the ‘ITS-90 Calibration 
Utility’ Screen. 
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3.5. OPTIONS VIEW SCREENS 
 
The following options are available under the “View” selection. 

 
 
The ‘Resolution’ selection provides access to the following sceen which allows you to select the 
resolution of the data that is displayed on the MAIN Screen. 
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The ‘Test Overview’ selection provides a graph of the current measurements as below.   
 
Select the ‘Next’ option and a window will appear allowing you to specify the file name and 
directory with the measurement data that you want displayed. 
 
Hit the ‘X’ tab on the upper right of the Test Overview screen to return to the “View” menu. 
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The ‘History Chart’ selection provides a history graph of the current measurements as below.   
 
Hit the ‘X’ tab on the upper right of the Test Overview screen to return to the “View” menu. 
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The ‘File Manager’ selection provides a subscreen as below. 
 
Select the ‘Directory’ or ‘Open’ options and a window will appear allowing you to specify the file 
name and directory. 
 
The ‘Print’ option sends the information on the File Manager screen below to a printer. 
 
The ‘Close’ option returns to the Options screen. 
 

 
 
 
The following options are available under the “Maintenance” selection. 
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The ‘Scanner’ option enables all specified scanner channels to be tested.  Note that it is 
recommended that this test be run at least once a month to ensure that relays used inside a scanner 
do not stick (i.e. lock in open or close position). 
 
The ‘Close’ selection return you to the Options screen. 
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The ‘Coefficients’ option allows you to display, print, or edit the calibration coefficients inside the 
6640T Bridge. 
Note that changing the calibration coefficients will affect the operation of the 6640T Bridge so a 
warning is displayed as below. Hit ‘OK’ to clear the warning message. 
Select the ‘Open’ or ‘Save’ options and a window will appear allowing you to specify the file 
name and directory respectively of the Coefficient file to use or save. 
Select the ‘Edit’ option to change the calibration coefficients. 
Note that the calibration coefficients in the 6640T Bridge are not changed until the ‘Upload’ 
selection is made. 
Select ‘Close’ to return to the Options menu. 
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The ‘System Setup’ allows you to enter the GPIB addresses for the 6640T Bridge and any 
connected scanners.  The ‘Configure 6623A’ option is not used for temperature measurements. 
 
The ‘OK’ selection returns you to the Options Menu. 
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3.6. MEASUREMENT OPERATION GUIDE 
 
This section contains information regarding the measurement of probes in the range of 1 mΩ to 
100 kΩ.  This guide is provided for manual control of the model 6640T Series bridge.  An 
operation guide for full automatic control of the model 6640T bridge, in thermometry applications, 
is provided in the BridgeWorks-ADV Software User’s Manual. 
 

Ref. 
(Ω) 

P.R.T. 
(Ω) 

Itest 
(mA) 

Imax 
(mA) 

Reversal 
Rate (sec) 

Comment 
 

1 0.25 10 100 20  
1 2.5 10 100 20  
10 25 1 31.6 20  
10 100 1 31.6 20  
100 100 1 10 20  

 
Table 3-1 : Recommended Temperature Measurement Test Setup 

 
NOTE: Itest is based on a 1 mW measurement (i.e. typically 1 mA or 10 mA).  

 
3.7. BRIDGEWORKS-ADV DATA ACQUISITION SOFTWARE 
 
The BridgeWorks-ADV Data Acquisition Software is the control software for the model 6645T 
System that operates on an external computer.  Using the 6640T with the BridgeWorks-ADV Data 
Acquisition Software will increase the functionality and the productivity of the bridge through a 
system level support for adding optional 6664C and/or 3210T Scanner(s).  These, along with other 
devices, can be added to work along with 6640T to create a fully automated temperature 
measurement system all under software control.  Before using the model 6640T system with the 
computer, ensure that the operation of the software package is well understood.  The internal 
embedded computer can be used to run BridgeWorks-ADV or optionally an external computer can 
control the system through the IEEE-488 Interface (GPIB) of the model 6640T Thermometry 
Measurement Bridge, and optionally, the model 6664C and 3210T Scanners. 

Refer to the BridgeWorks-ADV Software User’s Manual for a description of the software functions 
and automated operation of the system under software control. 
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4. MAINTENANCE 
4.1. INTRODUCTION 
This section covers troubleshooting, repair and alignment of the model 6640T Series Automatic 
DCC Resistance/Thermometry Bridge. 

 
4.2. TEMPERATURE RATIO VERIFICATION 
This section outlines the recommended thermometry based ratio verification requirements for the 
model 6640T bridge. 

4.2.1. PURPOSE 
The purpose of the procedure in this section is to assure that the model 6640T Series 
Bridge functions properly and meets the manufacturer’s specifications.  It is recommended 
that these procedures be performed after any corrective maintenance activity, or if the 
operator perceives a problem. 

It is recommended that all of these procedures be performed on an annual basis to verify 
performance of the model 6640T and for its recertification. 

4.2.2. EQUIPMENT REQUIRED 
 

The following equipment is required for this procedure. 

 
- 10 Ω standard resistor, stable to ±0.01 µΩ/Ω over a 24 hour period (x2) 
- 100 Ω standard resistor, stable to ±0.01 µΩ/Ω over a 24 hour period (x2) 
- 1 kΩ standard resistor, stable to ±0.01 µΩ/Ω over a 24 hour period (x2) 
- 25 Ω standard resistor, stable to ±0.01 µΩ/Ω over a 24 hour period 
- 400 Ω standard resistor, stable to ±0.2 µΩ/Ω over a 24 hour period  
- Temperature controlled environment sufficient to maintain the reference and working 

standard resistors to their specified uncertainties 
 
Note: The eight standard resistors are available in the optional model 6634A Resistance 

Standard. 
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4.3. MODEL 6640T BRIDGE VERIFICATION 
The following procedure is can be automated in using a test sequence BridgeWorks-ADV Data 
Acquisition Software if the 6640T is connected through a 6664C scanner. 
 

4.3.1. Set Up 
1. Ensure that the model 6640T is switched on, as well as the optional 6664C and 

6634A Resistance Standard if installed.  Open the BridgeWorks Data Acquisition 
Software in the computer. 

4.3.2. Inputs-Outputs Verification 
1.  Have the following resistors ready for connection to the 6640T or pre-connected to 

scanner  channel leads from the optional 6664C scanner as listed below: 
Resistor  
10 Ω  
25 Ω  
25 Ω (2)  
100 Ω  
100 Ω (2)  
300 Ω 
1 kΩ  
1 kΩ (2)  

Set these standard resistors into the controlled temperature environment and allow time for 
them to stabilize.  NOTE that without a tightly controlled temperature environment (e.g. 
0.05 Deg C or better) most resistors will not be stable enough to perform a bridge 
verification. 
 

2. Use the “Test Sequence” function of the “Configuration” menu of the 
BridgeWorks-ADV Data Acquisition Software to measure the resistance ratio of each 
resistor pair with the corresponding excitation current and reversal rate listed below.  
See the BridgeWorks-ADV Software User’s Manual for the particulars of running a 
test sequence.  These measurements can also be made manually.  If they are made 
manually, allow sufficient time for the measurement to settle and ensure that all 
measurements  related to a given closure are within 24 hours of each other. 
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Meas. 
No. 

RX 
Resistor 

Rs 
Resistor 

Excitation 
Current 

Reversal 
Rate 

Meas. 
Mode 

Tests 1 – 13 for all 6640T bridges. 
1 25 Ω 25 Ω 1.0 mA 20 sec Normal 
2 25 Ω 25 Ω 1.0 mA 20 sec Normal 
3 100 Ω 100 Ω 1.0 mA 20 sec Normal 
4 100 Ω 100 Ω 1.0 mA 20 sec Normal 
5 25 Ω 10 Ω 1.0 mA 20 sec Normal 
6 100 Ω 25 Ω 1.0 mA 20 sec Normal 
7 100 Ω 10 Ω 1.0 mA 20 sec Normal 
8 300 Ω 100 Ω 1.0 mA 20 sec Normal 
9 1 kΩ 300 Ω 1.0 mA 40 sec Normal 
10 1 kΩ 100 Ω 1.0 mA 40 sec Normal 

 
3. For each resistor pair, calculate and report the interchange closure error. For example, if 

the Rx:Rs ratio of the first measurement is Ra and the Rx:Rs ratio of the second 
measurement, where the two resistors are exchanged with one another, is Rb; then the 
interchange error ei in parts to the 106 of the nominal ratio is: 

  ei = (1/2) x Ra x Rb -1 x 106 

 
4. The maximum allowable interchange closure errors (in parts to the 106) for the 

following resistor pairs operating at 1 mW of power are: 
 

Resistor Resistor Interchange Closure Error 
-B -XP 

10 Ω 1 0 Ω 0.05 0.02 
100 Ω 100 Ω 0.05 0.02 
1 kΩ 1kΩ 0.05 0.02 
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5. For the first 10:1 ladder up closure error (100:10), the 10:1 ratio must agree to within 
the specification of the nominal ratio for either directly measuring the 10:1 ratio, or 
calculating the ratio from the product of the 10:2.5 ratio and the 2.5:1 ratio, as 
follows: 

  ei = (1/3) x Ra - Rb x Rc /10 x 106  
Where: 

Ra is the 10:1 ratio 
Rb is the 2.5:1 ratio 
Rc is the 10:2.5 ratio 

 
6. For the second 10:1 ladder up closure error (1k:100), the 10:1 ratio must agree to 

within the specification of the nominal ratio for either directly measuring the 10:1 
ratio, or calculating the ratio from the product of the 10:4 ratio and the 4:1 ratio, as 
follows: 

  ei = (1/3) x Ra - Rb x Rc /10 x 106  
Where: 

Ra is the 10:1 ratio 
Rb is the 4:1 ratio 
Rc is the 10:4 ratio 
 

7. For the 100:1 ladder up closure error (1k:10), the 100:1 ratio must agree to within the 
specification of the nominal ratio for either directly measuring the 100:1 ratio, or 
calculating the ratio from the product of the 100:10 ratio and the 10:1 ratio, as 
follows: 

  ei = (1/3) x Ra - Rb x Rc /100 x 106  
Where: 

Ra is the 100:1 ratio 
Rb is the 100:10 ratio 
Rc is the 10:1 ratio 
 

8. The maximum allowable ladder up errors (in parts to the 106) for the following resistor 
sets operating at 1 mW of power are: 

 
Resistor Resistor Resistor Ladder Closure Error 

-B -XP 
10 Ω 25 Ω 100 Ω 0.05 0.02 
100 Ω 400 Ω 1 kΩ 0.05 0.02 
10 Ω 100 Ω 1 kΩ 0.05 0.02 
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5. REMOTE CONTROL 
MODEL 6640 PROGRAMMING COMMAND SUMMARY 
 
A brief description of each of the possible remote IEEE-488 commands and their syntax in BNF 
(Backus Naur Form) follows: 
 - words inside angle brackets (ie. < and > ) are defined items 

 - :== means "is defined to be" 
 - | means "or" 
 - [] means optional  
 - required letters are shown in upper case but may be upper or lower case.  

 <digit> :== 0|1|2|3|4|5|6|7|8|9 
 <letter> :== A|B|C|...|Z|a|b|c|...|z 

 <string> :== <letter> | <letter><string> 
 <boolean> :== 0|1 

 <unsigned> :== <digit> | <digit><unsigned> 
 <nr1>  :== [+|-]<unsigned> 
 <nr3>  :== <nr1>[.[<unsigned>]][E<nr1>]  

 <?>  :== <letter> | <digit> 
 <*>  :== <?> | [<*>] :not to be confused with *  
 <DD>  :== <unsigned> : limited to range 1...31  
 <MM>  :== <unsigned> : limited to range 1...12  
 <YYYY> :== <unsigned> : limited to ranges 1999 and up  
 

 The STB Bits are as follows: 
 bit 7 = (unused) 
 bit 6 = SRQ (service request) 

  ; set when (SRQ_mask|GPIB_STAT_PORT) != 0 
 bit 5 = ESB (event summary)  

  ; set when bitwise AND of ESE, register is not zero 
 bit 4 = MAV (message available) 
  ; set when GPIB Tx buffer has data available 
  ; cleared when the buffer is empty 
 bit 3 = IFL (input buffer full) 
  ; set when input buffer is over 80% full 
  ; cleared when input buffer drops under 20% full 
 bit 2 = CHK (Checksum calculation complete) 
 bit 1 = RDY (ready) 
  ; set when unit has a stable reading  
  ; cleared when unit is working 
 bit 0 = OVR (over range) 
  ; set when over range detected (in ISR) 
  ; cleared when over range cleared 
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COMMAND COMMENT 
 
*CLS clear status register 
*ESR? query, display event status register 
*ESE? query, display event status enable 
*ESE <unsigned> set event status enable  
*IDN? query, display identity of unit 
*OPT? query, display any reportable options 
*OPC? query, operation complete 
*OPC set operation complete bit in event status register 
*RST reset the instrument to a known defined state 
*STB? query, display serial poll status byte 
*SRE? query, display service request mask 
*SRE <unsigned> set the service request mask 
*TST? query, display results of self test 
 
FETCh? fetch the most recent data value 

 
MEASure - set the measurement parameters 

 
MEASure <state> select the measurement state 
 <state>:== 0|1 
 type <boolean> 
 0 :== OFF 
 1 :== ON 
 
MEASure? query, display the measurement state of the 
 instrument 
 
MEASure:UNIT <unit> select the units of measurement and instrument 
 operation 
 <unit> :== R|O|C|F|K|V 
 type <letter> 
 R:==Ratio 
 O:==Ohms 
 C:==Celsius 
 F:==Fahrenheit 
 K:==Kelvin 
 V:==Volts 
 
 
MEASure:UNIT? query, display the units of measurement 
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COMMAND COMMENT 
MEASure:FILTer <function> setup the digital filter for the display data 
 <function>:== 0|1|2 
 type <digit> 
 0 :== Filter OFF 
 1 :== Decimation 
 2 :== Simple average 
 
MEASure:FILTer? query, display the filter setup 
 
MEASure:UPDAte <rate> set the number of screen updates for each 
 measurement cycle 
 <rate>:== 0|1|2 
 type <digit> 
 0:==1 updates/cycle 
 1:==2 updates/cycle 
 2:==4 updates/cycle 
 
MEASure:UPDAte? query, display the screen update rate setting 
 
MEASure:DEVIation <diff> select the method of reporting the difference data 
 <diff>:==0|1|2|3|4 
 type <digit> 
 0 :== disable/normal 
 1 :== parts per million 
 2 :== delta change 
 3 :== ppm from datum 
 4 :== delta from datum 
 
MEASure:DEVIation? query, display the method of reporting the difference 
 data 
 
MEASure:RESOlution <prec> select the precision of reporting the data 
 <prec>:==0|1|2|3|4 
 type <digit> 
 0 :== 0.001 ppm 
 1 :== 0.01 ppm 
 2 :== 0.1 ppm 
 3 :== 1.0 ppm 
 4 :== 10.0 ppm 
 
MEASure:RESOlution? query, display the precision of reporting the data 
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COMMAND COMMENT 
MEASure:VOLT <state> set the state of the nanovoltmeter to measure input 

voltages at the  potential terminals 
 0:== OFF 
 1:== ON 
 
MEASure:VOLT? query nanovoltmeter status 
 
MEASure:QUICk <state> select the quick measurement state 
 <state>:== 0|1 
 type <boolean> 
 0 :== OFF 
 1 :== ON 
 
MEASure:QUICk? query, display the quick measurement state of the 
 instrument 

 
CONFigure - configure instrument operating parameters 

 
CONFigure:DATUm <unit>, <value> initialize the datum to be used as the set point 
 in all difference calculations 
 <unit> :== R|O|C|F|K|V 
 type <letter> 
 R:==Ratio 
 O:==Ohms 
 C:==Celsius 
 F:==Fahrenheit 
 K:==Kelvin 
 V:==Volts 
 <value>:==<nr3> 
 
CONFigure:DATUm? query, display the datum used as the set point 
 in all difference calculations 
 
CONFigure:FILTer <size1>,<size2>  initialize the filter coefficients 
 <size1> :== <nr3> 
 decimation filter coefficient 
 <size2> :== <unsigned> 
 N average filter coefficient 
 
CONFigure:FILTer? query the filter coefficients 
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COMMAND COMMENT 
CONFigure:RESIstor <md>, <RS_SN>, <SN>, <RX>, <Rev_Rate>, <Tst_Val>, <Tst_Max> 
 set the active resistor measurement  
 configuration 
 <mode>:== 0|1|2| 
 type <digit> 
 0:==normal mode 
 1:==high ohms mode 
 2:==low ohms mode 
 <RS>:==<nr3>  
 ref. resistor value 
 <RS_SN>:==<string> 
 ref. resistor serial # 
 <RX>:==<nr3> 
 approximate value Rx 
 <Rev_rate>:==<nr3> 
 test current reversal rate 
 <Tst_Val>:==<nr3> 
 test current/volts 
 <Tst_Max>:==<nr3> 
 max current(Is)/volts for ref resistor 
 
CONFigure:RESIstor? query, display active resistor configuration 
 information 
 
CONFigure:RESIstor:DISPlay <unit>, <rate>, <filter>, <size>, <power> 
 set the active display parameters for resistor 
 measurements 
 <unit>:== R|O 
 type <letter> 
 R:==Ratio 
 O:==Ohms 
 <rate>:== 0|1|2 
 type <digit> 
 0:==1 updates/cycle 
 1:==2 updates/cycle 
 2:==4 updates/cycle 
 <filter>:== 0|1|2 
 type <digit> 
 0 :== none 
 1 :== decimation 
 2 :== simple average 
 <size>:==<unsigned> 
 size = % for decimation 
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COMMAND COMMENT 
 = sample size for simple average 
 <power>:== 0|1|2 
 type <digit> 
 0 :== power normal X1 
 1 :== power X2 
 
CONFigure:RESIstor:DISPlay? query, display the active resistor display setup 
 
CONFigure:PROBe <RS>, <RS_SN>, <R0>, <PRT_SN>, <Rev_Rate>, <Tst_Val>, <Tst_Max> 
 set the active probe measurement  
 configuration 
 <RS>:==<nr3>  
 ref. resistor value 
 <RS_SN>:==<string> 
 ref. resistor serial # 
 <R0>:==<nr3> 
 Probe resistance at ice point (IPTS68) 
 Or triple point of water (ITS90) 
 <PRT_SN>:==<string> 
 probe resistor serial # 
 <Rev_rate>:==<nr3> 
 test current reversal rate 
 <Tst_Val>:==<nr3> 
 test current/volts 
 <Tst_Max>:==<nr3> 
 max current(Is) for ref resistor 
 
CONFigure:PROBe? query, display active probe configuration 
 Information; response includes all associated 
 coefficients 
 see CONF:PROB:PCOE? 
 and CONF:PROB:NCOE? 
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COMMAND COMMENT 
CONFigure:PROBe:DISPlay <unit>, <rate>, <filter>, <size>, <power> 
 set the active display parameters for probe 
 measurements 
 <unit>:== R|O|C|F|K 
 type <letter> 
 R:==Ratio 
 O:==Ohms 
 C:==Celsius 
 F:==Fahrenheit 
 K:==Kelvin 
 <rate>:== 0|1|2 
 type <digit> 
 0:==1 updates/cycle 
 1:==2 updates/cycle 
 2:==4 updates/cycle 
 <filter>:== 0|1|2 
 type <digit> 
 0 :== none 
 1 :== decimation 
 2 :== simple average 
 <size>:==<unsigned> 
 size = % for decimation 
 = sample size for simple average 
 <power>:== 0|1|2 
 type <digit> 
 0 :== power normal X1 
 1 :== power X2 
 2 :== power X0.5 
 
CONFigure:PROBe:DISPlay? query, display the active probe display setup 
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COMMAND COMMENT 
CONFigure:PROBe:COEFficient <equation_#>, <coeff_00>, <coeff_01>, .., <coeff_n> 
 set the active probe conversion coefficients 
 measurements 
 <equation_#>:== <unsigned>: 
 equation_# takes on a value in the range 00 through  
 11 for the temperature calibration range of the probe 
 <coeff_00>:==<nr3> 
 <coeff_xx> are coefficients 01 through n for the  
 probe ITS90 conversion algorithm. 
 When <equation>:==00 the IPTS68 coefficients can  
 be set. 
 
CONFigure:PROBe:PositiveCOEfficient? query, display the active probe positive 
 temperature coefficients 
 
CONFigure:PROBe:NegativeCOEfficient? query, display the active probe negative 
 temperature coefficients 
 
CONFigure:VOLTmeter <range>, <zero>, <high>, <ref> 
 set the voltmeter calibration coefficients 
 <range>:== 0|1|2|3|4 
 type <digit> 
  
 1:== 2V range 
 2:== 200 mV range 
 3:== 20 mV range 
 4:== 2 mV range 
 <zero>:==<unsigned> 
 <high>:==<unsigned> 
 <ref>:==<nr1> 
 
CONFigure:VOLTmeter? <Range> query, display the voltmeter calibration setup 
 <range>:== 0|1|2|3|4 
 type <digit> 
 0:== 20 V range 
 1:== 2 V range 
 2:== 200 mV range 
 3:== 20 mV range 
 4:== 2 mV range 
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COMMAND COMMENT 
SYSTem - set the unit system settings 

 
SYSTem:COMMunicate:GPIB <address>, <mode>  
 setup GPIB communications 
 <address>:== <unsigned> 
 <mode>:== 0|1|2 
 type <digit> 
 0 :== disable 
 1 :== talk only 
 2 :== talk/listen 
 
SYSTem:COMMunicate:GPIB? query, display GPIB set up 
 
SYSTem:TERSe respond to commands with a minimum data 
 Set 
 
SYSTem:VERBose respond to commands with a minimum data  
 Set 
 
SYSTem:VERSion? query, display the installed software version 
 
SYSTem:DIAGnostic:ROMChecksum? query, display rom checksum 
 
SYSTem:DIAGnostic:SERialNumber <number> 
 assign serial number 
 <number>:==<unsigned> 
 Diagnostic Command Set 
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COMMAND COMMENT 
SOFCAL - set the unit calibration details 

 
SOFCAL:COEF <ratio>, <range>, <corr>, <uncert> 
 <ratio>: == 0|1|2|3|4|5 
 0:==0.1:1 ratio 
 1:==1:1 ratio 
 2:==1:1 ratio (648 turns) 
 3:==10:1 ratio (648 turns) 
 4:==10:1 ratio (81 turns) 
 5:==100:1 ratio 
 type<digit> 
 <range>: == 0|1|2|3|4|5|6|7|8 
 type<digit> 
 0:==1 Ω Rs range       
 1:==10 Ω Rs range 
 2:==100 Ω Rs range  
 3:==1 kΩ Rs range 
 4:==10 kΩ Rs range  
 5:==100 kΩ Rs range       
 6:==1 MΩ Rs range 
 7:==10 MΩ Rs range  
 8:==100 MΩ Rs range 
 <corr>:==<nr3>  
 correction coefficient (parts in 106of ratio) 
 <uncert>:==<nr3>  
 uncertainty (parts in 106 of ratio) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

Section 5 
 

OM6640T-10-00 
08 March 2024   

5-11 

COMMAND COMMENT 
SOFCAL:COEF? <ratio>, <range> query, display ratio correction coefficient 
 <ratio>: == 0|1|2|3|4|5 
 0:==0.1:1 ratio 
 1:==1:1 ratio 
 2:==1:1 ratio (648 turns) 
 3:==10:1 ratio (648 turns) 
 4:==10:1 ratio (81 turns) 
 5:==100:1 ratio 
 type<digit> 
 <range>: == 0|1|2|3|4|5|6|7|8 
 type<digit> 
 0:==1 Ω Rs range       
 1:==10 Ω Rs range 
 2:==100 Ω Rs range  
 3:==1 kΩ Rs range 
 4:==10 kΩ Rs range  
 5:==100 kΩ Rs range       
 6:==1 MΩ Rs range 
 7:==10 MΩ Rs range  
 8:==100  Ω Rs range 
 
SOFCAL <beta> set adc beta 
 <beta>: == <unsigned> 
 200 <= beta < 300 
 
SOFCAL? query, display adc beta for the nanovolt detector 
 
SOFCAL:GET Calculate adc beta for the nanovolt detector 
 
SOFCAL: FREQuency <Hz> set the line frequency option 
 <Hz>: = = 011 
 type <digit> 
 0 : = = 60 Hz 
 1 : = = 50 Hz 
 
SOFCAL:DATE<YYYY>,<MM>,<DD set the calibration date 
 <YYYY> calibration year 
 <MM> calibration month 
 <DD> calibration day 
 
SOFCAL:DATE? query, display the calibration date 
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COMMAND COMMENT 
SOFCAL:PRIM<state> set the primary turns lock 
 <state> 0|1|2 
 type<boolean> 
 0:== unlocked 
 1:== locked to 81 turns 
 2:== locked to 648 turns 
 
SOFCAL:PRIM? query, display the primary turns lock 
 

Low-Level Hardware Commands 
 
ADconvRead? query, display adc reading in engineering units 
 
ADconvB? query, display adc in raw binary units 
 
Filter <function> set the nano voltmeter filter 
 <function>:==0|1 
 type <boolean> 
 0:== OFF 
 1:== ON 
 
Filter? query, display the nano voltmeter filter setting 
 
Highres <resolution> set the high resolution mode 
 <resolution>:==0|1 
 type <boolean> 
 0:== OFF 
 1:== ON 
 
Highres? query, display the high resolution mode setting 
 
HardWareFilter <status> set the hardware filter status 
 <status>:==0|1 
 type <boolean> 
 0:== OFF 
 1:== ON 
 
HardWareFilter? query, display the hardware filter status 
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COMMAND COMMENT 
IXTurns <turns> set relay turns 
 <turns>:==<unsigned> 
 0≤turns≤8747 
 
IXTurns? query, display relay turns setting 
 
ISDAC <value> set dac setting 
 <value>:==<nr1> 
 value == ±5 Volts 
 
ISMux <channel> set the multiplexer channel 
 <channel>:==0|1|2|3|4|5|7 
 type <digit> 
 0:== servo 
 1:== speedup 
 2:== offset 
 3:== +40 V 
 4:== -40 V 
 5:== primary current 
 7:== calibrate 
 
ISMux? query, display the multiplexer channel 
 
ISResolution <resolution> set the resolution 
 <resolution>:==0|1|2 
 type <digit> 
 0 :== high 
 1 :== medium 
 2 :== low 
 
ISResolution? query, display the resolution setting 
 
ISSpeed <speed> set the speed 
 <speed>:==0|1|2|3 
 type <digit> 
 0 :== reset 
 1 :== slow 
 2 :== moderate 
 3 :== fast 
 
ISSpeed? query, display the speed setting 
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COMMAND COMMENT 
OHmmode <mode> set the ohm mode 
 <mode>:==0|1|2 
 type <digit> 
 0 :== normal  
 2 :== low ohms 
 
OHmmode? Query, display the ohm mode 
 
Range <range> set the nanovoltmeter range 
 <range>:==<unsigned> 
 range any one of 
 0.002, 0.02, 0.2, 2.0, 20.0 
 
Range? query, display the selected range 
 
Voltage? query, display the nanovoltmeter measurement 
 
RESET reset instrument to power on reset state 
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